
オージェマイクロプローブ
(AES)簡易マニュアル 

光電子分光分析研究室 

 

 

 
連絡先 坂入正敏 内線7111 

     鈴木啓太 内線6363/6882 

2014/03/19更新 

 
 

1 



装置使用の前に 
以下のルールを守って下さい。 

• 研究室内は土足厳禁、飲食厳禁です。ゴミはきちんと片づけてく
ださい 

• 装置の故障、不具合を見つけたらすぐにスタッフに連絡して下さ
い 

• 装置を乱暴に扱わないでください 
• 研究室の物を勝手に持ち出したり、無くしたりしないでください 

• 貴重品の管理は各自でお願いします。長時間部屋から抜ける場
合などは、研究室の施錠も各自で行ってください 

• ステージの移動操作時、各装置のステージ位置稼働制限を守っ
て下さい。動かし過ぎると試料が検出器にぶつかり、故障します 

• ソフトウェア、ハードウェア上のパラメータなどを変更した場合、
装置使用後に必ず設定を元に戻してください 

• 分析装置PCに直接自分のUSBなど記録メディアを差し込まないで
ください。当研究室USBを差し込み、解析用PCを迂回させてデー
タを取り出すか、オージェ解析用PC内のAESネットワークフォルダ
から直接データを取り出してください。 

• 分析室内に導入するものは全て素手で触らないでください。汚し
た場合は自分で洗浄してください 

• 使用者が予約を取って、予約時間通り使用して下さい。予約時
間からずれ込む場合は予約を事前に変更して下さい 

• 深夜早朝祝休日に使用する場合、使用中のトラブルは全て貴研
究室の責任で対応して下さい。なお、緊急連絡先は研究室入口
ドアの横に記載してあります 

• 初めて使う方は事前にスタッフに連絡を取って、講習を受けてく
ださい 

• ガスの出やすい試料、大きすぎる試料、壊れやすい試料など、
分析室真空度を劣化させる試料を勝手に入れないでください。心
配な試料は事前にスタッフにご連絡ください 
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装置使用の前に 

 使用記録簿に日時、開始時間、
氏名、研究室名、分析室真空度
(使用前)、試料情報、ナノテク番号
を記載してください 

 ボールペンを無くさないように 

 分析室真空度、イオン化室真空度
の値を確認してください 

 異常に劣化している場合はスタッフ
にご連絡ください 
平常時：分析室10−7~10−8Pa 
      ：イオン化室10−3~10−4Pa 

 AESのPC、ソフトウェアは常時立ち
上げたままになっています 

 ディスプレイの電源だけをつけてく
ださい 
 SEMソフトウェア、オージェマスター

が消えている場合は立ち上げ直して
ください 

オージェPCはラックの下です 

オージェ解析用PCは←左図のPCです 
有線でオージェPCと繋がっているのでデータのやり

取りをネットワークを介して行えます。解析について
もオージェソフトウェアが入っているので行えます。
基本的に解析はこちらで行ってください 
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試料の準備 

 オージェ分析ではコンタミ(試料汚染)が

分析に強く影響を与えます。出来るだけ清
浄な表面を用意して下さい 
・出来るだけ大気非暴露な環境で保存 

・超音波洗浄(純水、エタノール、アセトンなど) 

・エアーガンなどで即座に乾燥 

・断面観察の場合はクロスセクションポリッシャ(CP)で平滑で清
浄な断面を出す 

・埃やゴミをエアーでよく飛ばす 

 試料の形状に合わせてホルダーを
選択し、試料を固定して下さい 
ホルダー等真空に引くものは素手で触らない 

・小型ホルダー(試料サイズ：厚み
4mm×12mmφ以下) 

・大型ホルダー(試料サイズ：厚み
5mm×20mmφ以下) 

・断面観察用ホルダー(試料サイズ：厚み
7mm×11mm×10mm以下) 
• 大型・断面ホルダーはチルト角度制限があり、55度ま
でしか傾けられません。EBSD測定などの際は小型を
選択 

 

 AES試料ホルダーは真空デシ

ケーターに保管してあります。
ポンプは常時稼働なので、大気
側、ポンプ側バルブを開け閉め
して取り出してください 

大気側：開 
ポンプ側：閉 

小型 大型 断面 
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試料の準備 

 小型ホルダーの横ネジを
外すと、ホルダー蓋部が外
れます。蓋部は2種類あり
ます 

 ホルダーの底と蓋で試料を挟み込むように
固定します。厚みがある場合は蓋部を分解し
てから試料を入れてください 
• 固定したらホルダーを振ってみて固定出来ているか確認 
• ネジ類はしっかり固定、ネジはなくなさいように 

 大型ホルダー
も分解可能です。
蓋は3種類あり
ます 

 断面観察用ホルダーは試料を左図の
ように挟み込みます。ホルダー下部に試
料を接地した方が安定します 

 固定が不十分な場合、または粉末試料な
どはカーボンテープなどで固定してください。
使用後はホルダーを洗浄して下さい 
• 試料のドリフトが気になる場合はペーストを使ってください。
使った場合は数時間真空引きする事 

• カーボンテープ他、銀ペースト、カーボンペースト、銅テープ、
普通の両面テープ、瞬間接着材などがあります 
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試料の導入 

 ホルダーの下の溝に
フォークを差し込みます 
• 使ったらフォークはアルミ箔で包んでく
ださい 

 試料導入室ドアのロック
を外します。VENTボタンを

押して導入室を大気に戻
します 
• VENTボタンを押すと緑に光ります 

 

 導入室内のフォークにホル
ダーの上の溝を差し込んで、
黒いリングを回して「閉」を上
にします 

 手に持ったフォークを抜き
取り、ドアを閉め、ロックをか
け、再びVENTボタンを押して
導入室を真空に引きます 
• 長時間導入室を大気に晒さないでくだ

さい。真空が劣化します 

 導入室でしばらく真空に引き続けます 
• 目安：金属板一枚なら30分、粉末試料なら2時間ほど 
 

 装置のオペレーター板の扉を開け、導
入室の真空度を確認します。針が振り
切れるまで真空に引いてください 

上げてから回す 

導入室の上から
中が覗けます 

回しすぎない 

↑これはまだ真空が引けます 
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試料の導入 
 真空を引いている間に、 
オージェマスター →file→saving 
conditionでデータの保存先、保
存名を決めます 
• 画像・スペクトルデータは保存名+連番で自
動保存されます 

• 保存名は6文字以内です 

• ディレクトリ名などに漢字や変な記号、空白
を入れると文字化けなどバグが起きます 

  

 オージェマスター→ observation 
→ sample  manipulation でウィンド
ウを立ち上げ、Special Positionをク
リック 

 立ち上がったウィンドウから
sample Change Position→Moveを
クリック。New holderからホルダー
の種類を選択し、Close 
• 小型→12mm  大型・断面→20mm 

 鏡筒横のコックが閉まってい
る事、PCDが入っている事、二
次電子検出器がOFFになってい
る事を確認する 
• PCDの状態はSEM上のアイコンの色を確認

(灰out緑in) またはオージェマスター→ 
observation→probe conditionからPCDを確認 

• コックを閉めると電子線がそこでブロックされ
ます 

• SEMのコントロール画面が消えてる場合は 
• このアイコンをクリック 

下についてる棒を回す 

閉まってます 
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試料の導入 

分析室の窓を開けます 

 黒いリングが後ろ端まで来ているのを
確認してからV2ボタンを押して分析室へ
のバルブを開けます 
• リングが後ろ端まで来てないと開きません 

 窓から分析室を覗きながら、黒
いリングをゆっくり押し出して試料
をステージに入れます。黒いリン
グを「開」へ回し、フックが外れた
のを確認してゆっくりリングを後退
させます 

 V2ボタンを押し、分析室へのバ
ルブを閉めます。窓も蓋をする 

 分析室の真空度を確認します。真空度が
5.0×10−6Paより悪い場合、ただちに試料を回
収して導入室で真空を引き直してください 
  5.0×10−6Paより真空度が良い場合はその
まま真空引きを続け、10−7Paオーダーまで真

空を引いて下さい。引き終わったら真空計を
OFF 
• 引きが悪いようなら導入室に戻して真空を引いた方が速いです 
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試料の観察 

 真空が10−7Paオーダーに到達

したら、鏡筒のコックを開けます。
オージェマスター→ observation 
→probe conditionでウィンドウを
開き、まずはOL→Lens Clear→OL
をクリックして消磁 
• 電磁レンズのヒステリシスを消磁します。ヒス
テリシスが残ってると軸合わせやオージェ分
析に支障が出ます。こまめにやりましょう 

開いてます 

 Probe Energyに電子ビームの加速電
圧、Auto Probe Currentに電流値を入
力し、Setボタンをクリック 
• 普通に使う場合は10kV,10nAに設定 
• PCDが入っていないと設定値になりません 
• 電圧値は５ｋV刻みで入れる 
• 電流値大きい方がオージェ分析で強度が取れます 
• COMPO・TOPO像を取る場合は大電圧、大電流推奨 
• EBSD時は１５ｋV推奨、電流値大き目 
• 微小領域を観察する際は電流値下げる 

  電圧・電流値の設定後、
PCDをout 
 二次電子検出器をon 
 SEM像が観察できる 
 

 観察したい場所へステー
ジコントローラー or sample 
manipulationで移動 
• sample manipulationでの移動を推奨 

• ホルダー種類に応じて自動で移動制限
してくれます 

• コントローラーは移動制限がないので
ぶつけないよう注意 

X,Y 移動 Tilt/rotation 

早送り 

HOLD on/off 

Z移動 
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試料の観察 
オージェ分析を行う場合 or Ar+イオンガンを使う場合 

・ユーセントリック位置へ移動する 

①tiltを１０度に傾ける 
②観察する場所でターゲット(見やすいもの)を
画面中心に移動させる(ｘｙで) 
③tiltを３０度に傾ける。その時ターゲットがSEM
画面で上に行ったか下に行ったか確認(横の移
動は無視) 

④上に行った場合ｚを下げ、下に行った場合ｚ
を上げてターゲットを元の位置まで戻す 
①~④までを50倍くらいから徐々に上げて1500
倍くらいまで合わせる(最後はtilt30度のまま) 

観察場所を大きく動かした場合はもう一度ユーセン
トリック位置の修正を行った方がいいです 

ユーセントリック位置からずれてるとイオンガンでう
まく削れません、オージェ分析の強度も出にくいで
す(出来ない訳ではない) 

・反射電子検出器の使い方
(COMPO・TOPO像観察) 

 分析室真空計をOnにし、窓を開け
て、AES本体の後ろ側にある黒いバ
ルブを、ネジを開けてからIN側へ止

まるところまで回す。中に反射電子
検出器が入るのを確認する 
 試料にぶつけないよう必ず目視確認 

 SEMソフトウェアの右下、SEIの表示を
クリックして、COPMO・TOPOを選択 
 電圧・電流が小さいとかなり見難いです 
 TOPO像は画面の上に光源があるような陰影がつきます 
 COMPO像は重い組成が明るく、軽い組成が暗く見える 
 どちらも大体100nmぐらいまでの深さを見てます 

ネジ緩める 

② 

③ 

③ 

④ 
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軸合わせと撮影 
 軸合わせはスキャンモードをRDC 
imageに切り替えてやりましょう 

 コントラスト・ブライトネスを調整し、
フォーカスとスティグマを軽く合わせま
す 
• スティグマがずれているとアンフォーカス時のぼやけ方
が一方向に伸びたようになります 

 次にHTウォブラをONにし、つまみを

回して周期的に観察像をぼかします。
ぼやけ方を確認して対物絞りのXYの
調整を行います 
• ぼやける時に観察像の位置自体がずれている場合は
対物絞りXYがずれています 

• 対物絞りの番号は通常4番で高倍率観察用になってい

ます。絞りの番号を小さくすれば、電流値をさらに上げ
る事が出来ますが、空間分解能が下がります 

 

 絞りの調整が出来たらもう一度
フォーカスとスティグマを調整します 
 
 ・コントローラーの説明 
 FINE VIEWでスキャンスピードを遅くし、
精細な像が取れます。スピードは2段
階あり、ボタンで切り替わります 
 FREEZEを押すとスキャンが1周終わっ
た時に像が固定出来ます 
 PHOTOを押すとFINE VIEWが始まり、
１周後にFREEZEされ、SEM像を保存す
るウィンドウが立ち上がります 
• 自分のフォルダを選択し、エクスポート or 保存 
•  SEM右下のバーや倍率を画像に載せる→エクスポート 

RDC image 

スティグマ 

コントラスト 
ブライトネス 

X
軸 

Y軸 

絞り変更 
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試料観察で使う機能 
 モードの番号を上げていくとSEM像が
見やすくなります 

•  二次電子検出器に電場をかけて検出効率を
上げています。オージェ分析時は0番に戻しま
しょう 

 スキャンローテーションをONにしてス
クロールを操作すると、像が回転します 
 ダイナミックフォーカスをONにしてスク

ロールで適切なレベルにすると高低差
のあるものでも全体のピントが合いや
すくなります 

 パレットボタンをクリックするとSEM像

上にテキスト書き込みや、ルーラーで
物のサイズなどを測ってスタンプ出来
ます 

 像の見え方を変える場合にはこのボ
タンをクリックします。コントラスト、ブラ
イトネス、ガンマ値を調整出来ます 

 ステージ移動なしに、SEM像上でマウス

ドラッグして像を動かす事が出来ます。動
かせる範囲はSample Manipulationの
Image Fine Shiftの範囲までです。初期値
(原点)に戻す場合は、←左図のアイコンを
クリックします 
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試料観察で使う機能 

試料を観察中に像が動いてしまう場合 
• BACKLASHボタンを押しBACKLASHを解
消する 

• 分析室に導入してしばらく待つ 

• 帯電が起きていないか確認、起きない
よう電圧電流値を調整 

• 試料セッティングをやり直す 

 現在のステージ位置を記憶させた
い場合は、Save PositionsのAddをク

リックします。複数のポイントを記憶
出来ます。呼び出す際はDetailをク
リックし、テーブル中のNumberを選
択し、Moveをクリックします 

 スポットボタンを押すと青色の十字が
像上に出てきます。もう一度押すと十字
が黄色に変わり、ビームがスキャン
モードからスポットモードに変わります。
十字のターゲット部分のみビームを照
射します。その間、像はフリーズします 

• 低倍率だとスポット位置が若干ずれます 

• スポットモードでビームを照射しながら簡易的に
オージェ分析にかける事が出来ます→分析点
指定をscanに変更 
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Ar+エッチング 
 オージェ分析に入る前に、試料のコンタ
ミネーションを除去します。Ar+のビームを
試料に撃ちこみ、最表面を削ります 

• 化学状態分析を行いたい場合にはこの工程は避け
た方が無難です。ビームの影響で材料の還元、アト
ミックミキシングなどが起こる可能性があります 

・Arガスの導入 
分析室真空度を確認！真空度が悪い場合は導入しない 

1. イオンガンの真空計でAVCをON 
2. Arガスバルブを反時計回りにゆっくり

回し、イオンガンの真空計で約
9.0 × 10−2Paまで上げる 
• 通常6時の方向に目印があり、一回転ほどでその

値になります。出し過ぎに注意！ 

3. オートバルブコントローラーの電源を
入れる 

4. オージェマスター→AES→Ion Gun 
ConditionでAuto Valve Controlにガ
ス圧7.5と入力し、Setをクリック 

5. ガス圧が指定の値に落ち着くのを待
つ 

・Ar+イオンを照射 

1. エッチングの条件をチャンネル番号か
ら選択 

2. エッチング時間を指定 
3. 二次電子検出器をoff、PCDをinにする 
4. EtchingのOnボタンをクリックすると照
射される 
• SEM像を中心におおよそ1×1mmの範囲が削れます 

オートバルブ 
コントローラー 

向かって右
の真空計 
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・中和電子銃を利用する 
 低速のAr+イオンを照射する事で－
電位を緩和します 
 Ar+エッチングを参照にArガスの導入、

ガス圧調整を行ってからオージェマス
ター→AES→Ion Gun Conditionで
Neutralizingメニューで中和電子銃の
Channelを設定し、Onボタンをクリック 
 照射したままスペクトルを取得します 

帯電しやすい試料について 

 試料の導通が取れないような試料の場合、電子ビームの照
射により試料がマイナス電位に帯電します 
 SEM像及びスペクトルの取得が困難になります。オージェで

は分析深さが非常に浅い為、カーボンや金の蒸着も分析上困
難なので他の手で帯電を緩和する方法を取ります 

・照射電流、スペクトル取得の設定 
 出来るだけ電圧、電流量を下げる 

• 実用的には5kV、1nAぐらいです 

 スペクトルを取る際はプローブ径を大
きくする。積算時間を下げてスイープ回
数を上げるorデフォーカスして測定する 

 Ch11からCh14まで各種ビーム設定の
用意があります 

・試料、ステージのセッティング 

 カーボンテープやペーストを利用して試
料の導通を取る。アルミホイルで分析箇
所以外をマスクする。絶縁体のゴミや過
度な凹凸を除去する 
 ステージを高傾斜する事で2次電子の
放出量を増やし、－電位を緩和する 
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オージェ分析 

分析方法には主に以下のような種類があります 
• wide scan ー 広いエネルギー範囲でスペクトルを取得、主に元素分析用 

• split scan ー 特定元素のエネルギーエリアだけを測定、主に状態分析用 

• line profile ー 線分析。特定元素のpeakとbackgroundの強度を取得し、 

              ラインプロファイルを作成 

• spectrum line profile ー 線分析。特定元素のエネルギーエリアを測定し、 

                                                                強度を計算、ラインプロファイルを作成 

• depth profile ー 深さ方向分析。Ar+エッチングとスペクトルスキャンを繰り返す 

• auger image ー 特定元素のpeakとbackgroundの強度を取得し、元素マッピング                      

                                             を作成 

分析の為に設定しなければならない事、やっておかなければならな
い事は主に以下のようになります 
1. 分析エリアの取り込み ー オージェマスターに分析エリアを取り込ませます 

2. 分析条件の設定 ー 分析モードの設定、測定するエネルギー範囲、ステップ、 

                                                       積算時間、積算回数、オートプローブトラッキング間隔を 
                                                       決めます 

3. 分析箇所の設定 ー分析する場所をpointかareaで指定、分析時のビームの 

                   スポットサイズも指定出来ます  

4. ROIの設定 ー 測定する元素の指定やpeak＆backgroundを指定します 

5. イオン銃の設定 ー イオンビームの出力や照射時間を設定、帯電時に使用 

                   する中和銃の設定も行います 

6. Auto probe trackingの設定 ー 試料が動いた場合、取得時の写真と比べ 

                          てビームをずらす事により、元の測定位置 
                          に修正します。試料が動きやすい＆高倍率 
                          &長時間での測定の場合に使います 

7. 予備測定 ー 本測定の前にスペクトルを収集し、安定したスペクトルが出ている 

             か確認します。データには残りません 

8. 本測定 － データが取得出来ます。積算回数などを途中で変更する事が 

             出来ます 16 



オージェ分析 wide scan 

１．分析エリアの取り込み 
 オージェマスター→ Observation → 
Start digital scanでSEM像がオージェに
取り込まれます 
• 解像度、積算回数、取り込み範囲を左のメニューで変更
できます  

２．分析条件の設定  
 オージェマスター→ AES → Spectrum 
→ Wide Scan Spectrumでwide scan用の
ウィンドウが立ち上がります 
 Wide scan Spectrum → Condition→ 
Analyzerでコンディションウィンドウが立
ち上がります 

・Analyzer mode選択 
M1：エネルギー分解能が測定エネルギー値によらず一定、パ
スエネルギーを指定する。値が小さいほど分解能良い 
M2～M5：エネルギー分解能が測定エネルギー値に比例して
下がる。M2の分解能が0.05%でM5だと0.6%となり、番号順で
悪くなるが逆に強度は高くなる。M2,3は主に化学状態分析時、
M4,5は組成分析時に使用 

・Wide Scan Conditions設定 
 測定したいエネルギー範囲指定 
 ステップ間隔、積算時間、積算回数指定 

• 積算回数は測定中に変更可能なのでスペクトルを 
• 見ながら適宜必要な回数に変更しましょう 

・Auto Probe Tracking設定(利用時) 
 Probe trackingを何回ごとに行うか設定 
 

 設定が終了すると測定にかかる時間が
Wide Scan Spectrumウィンドウ左下に表示さ
れます 
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オージェ分析 wide scan 

３．分析箇所の設定 
  Wide scan Spectrum → Condition→ 
Analysis Position でオージェマスターに取
り込んだ画像から分析箇所を指定します 
• 過去に取った画像を読み込んで指定する事も可能 

・分析箇所の指定 
 チェックボックスを押す 
 Scan mode選択 

• Scanを選ぶとSEMの設定に準拠します。1番
にScanを選んでSEMでスポットモードを使い、
preacquisitionで簡易的に分析が出来ます 

 

 分析箇所を指定 
 Probe Dia. Resolutionの指定 

• probe dia.を0にしていると現在のビーム径
になります(大体10nm)。それ以外の値を入
れると指定したビーム径(μm)に広がり、広

範囲に分析する事で平均的で安定したス
ペクトルが取得出来ます。resolutionは主に

ラインプロファイル、マッピングの際に分析
箇所をどのくらいの解像度で分析するかで
設定します 

 ６．Auto probe trackingの設定(利用時のみ) 

 予め 、Image Fine Shiftを原点に戻してオージェマスター 
へのSEM像取得を行っておくこと。この機能はImage Fine Shiftを

使って位置修正を行うので、初めから動けるエリアぎりぎりの位
置にいると上手く使えません 

 オージェマスター→AES→Probe tracking 
control をクリック 
 File→ReloadでSEM像を取り込む 
 AutoをOnに切り替える 
 解像度と積算回数を適当な値に指定 
 Correct Pos.を押して正常に働くか確認 

 
 

18 



オージェ分析 wide scan 
７．予備測定 
 Wide Scan Spectrum →Preacquisition 
→Startで予備測定が始まります 
• 上側に測定スペクトルが表示され、下側にその微分形

が表示されます。青色が一つ前の測定で赤色がリアル
タイムの測定です。スペクトルの形状が安定していれ
ば本測定に移れます。この測定データは残りません。
Stopしないと永遠に続きます。出来れば全ての分析点

を予備測定して確認してください。
Preacquisition→Restartから分析点を変更出来ます 

・スペクトルがいつまでも安定しない場合 
  試料が動いている 
 チャージが起きている 
 試料がビームのダメージで変質している、還元している 
 分析点が相の中間になっている 
 コンタミネーションが付着している 
等々が起きている可能性があるので除外していきましょう 

・Auto probe trackingを使う場合 
 予備測定中にもAuto probe trackingが
働くので、Image fine shiftで一回の修正
でどのくらい移動しているか確認 
• X,Y軸の移動量の合計が概ね４以下になるようにprobe 

trackingをかける間隔を調整するか、試料のドリフトが収ま

るまで予備測定を続ける。移動量が大きすぎる状態で本測
定を行っても分析位置がかなりずれている事になります 

８．本測定 
 Wide Scan Spectrum →acquisition 
→Startで本測定が開始されます 
 途中で止める場合はStopを選択。
Pauseで止めると電流量やステージ位

置などのパラメータを変更後、再開出
来ます 
• 装置にもたれかかったり、大声で騒いだりすると分

析位置がずれます。静かにしてましょう 
19 



オージェ分析 split scan 

２．分析条件の設定  
 オージェマスター→ AES → Spectrum 
→ Split Scan SpectrumでSplit scan用の
ウィンドウが立ち上がります 
  Analyzer Conditionの設定はwide 
scanを参照 

４．ROIの設定 
 Split Scan Spectrum →Conditions 
→ROI  Condition(split)でウィンドウが
立ち上がります 

 一つ前に取ったスペクトルが表示さ
れます。下のテーブルから測定したい
元素を指定し、番号のボタンをクリッ
クします。スペクトル上に測定する範
囲が水色で囲まれます 
• 無い場合は適当な番号を選んで新たにNameに元素
を入力しEnter、さらにEnterボタンをクリックすると元素
を新規登録出来ます 

 

 スペクトルを確認しながら各元素の
測定範囲を調整します。水色のバー
を操作するか、登録テーブルに入力し
てください。他、積算時間やスイープ
回数、Step幅も指定します 
• 登録テーブルの数値入力は最後にEnterボタンをク
リックしないと反映されません 

• スペクトルの表示拡大はResizeをクリックしてからマウ
スで拡大が出来ます。ROIの設定に戻る場合はROIを

クリックします。また別のスペクトルを参照したい場合
はFileからデータを指定して開き直せます 

 
あとはwide Scanと同様です   

Selected ROIをクリックすると測定予定の
元素のスイープ回数を変更出来ます 
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オージェ分析 line profile 

２．分析条件の設定  
 オージェマスター→ AES → Line Profile → Line 
ProfileでLine Profile用のウィンドウが立ち上がり
ます。Analyzer modeとAuto Probe Trackingを設定
します 

４．ROIの設定 
 基本的な操作はsplit scanを参照 
 ここではLine Profileの強度を作るPeakと
Backgroundを２つの方法で設定します。
強度の定義についてはInt.Def.から選択し
ます。基本(P-B)/Bで問題ありません 
• Bで割る事で、分析箇所の凹凸による影響を緩和してます 
 

・PB別(Separate)法 
 Sampling MethodでSepareteを指定 

 測定する元素を設定後に、各元素につ
いて、PとBを、それぞれピークの位置と

バックグラウンドのエネルギー位置に指
定します。スペクトル上の水色のバーで
は左側バーがピーク、右側バーがバック
グランドになります。Pのエネルギー値、B

のエネルギー値のところだけを順次測定
する事になります。 
• PB同時法に比べて設定が楽です。ピークが見えていれば問
題なく取れますが、PB同時法より測定時間を食います。Pが
小さく、右上がりのBよりも強度が低い場合などは取れませ
ん。またPとBの設定を後から変更する事が出来ません 

 
←のようにピークとバックグラウンドにPと
Bを設定します 
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・PB同時(Simultaneous)法 
 Sampling MethodでSimultaneousを指定 
 PB同時法ではPとBを別個に測定せず、

７つある検出器にそれぞれ担当を決めさ
せて一度に取得します 
 元素を指定後、CEMボタンをクリックする
とP/B Simultaneous Conditionが立ち上が
ります。 
 
・CEMの設定 

 測定する元素のピークとバックグラウン
ドが見えやすいように表示の幅を調整 
 analyzer ModeをM1に変更し、Epの値を
RangeがPとB両方が-3chから3chの間に収
められる幅になるよう整える 

• -3chから3chまでの7channelは各検出器の名称です。

下の数値は各検出器が測定するエネルギー値です。
Ep(パスエネルギー)を変えると7つの検出器が測定す
る全体のRange(エネルギー幅)が変わり、測定するエ
ネルギー値も変わります 

 各チャンネルのエネルギー値を整えてそ
れぞれP担当、B担当を割り振る 
 最後にLoad Center of CEMをクリック 

• 各検出器でゲインにばらつきがあるので中央のチャ
ンネルを使ってこれを補正しています  

 順次、各元素でCEMを設定する 

オージェ分析 line profile 

↑上のような場合は-3chと3chをBと指定、他をPと設定すると良いで
す。基本的に0chをピーク中心に持ち込み(スペクトル上のバーを動か
す事で指定出来ます)、Epに適切な値を入れて-3chと3chをBに届くよ

うにすると良いでしょう。ピークが低エネルギー側に裾野を広げるタイ
プの場合は高エネルギー側だけをBにして残りをPにするなどもアリで
す。またPBの他Noneを指定して測らないという事も設定出来ます 
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オージェ分析 line profile 

３．分析箇所の設定 
  Line Profile→ Condition→ Analysis 
Position でオージェマスターに取り込んだ
画像から分析するラインを指定します 
 Directionで縦軸か横軸かを指定し、
Resolutionで解像度を指定します 
• 例えばSEM像全体が5μmほどの幅で解像度を128に設定す
ると1stepあたり40nmごととなります。オージェの分析径は
おおよそ10~20nmなのでstep幅はこれ以上小さくしてもあま
り精度が良くないです 

  

 あとはwide scanと同じです。予備測定
はありません 

 本測定を始めると上には測定している
各元素のP(赤)、B(青)の強度/ピクセルの

グラフが表示されます。下には各元素の
定義された強度/ピクセルのグラフが色分
けされて表示されます。Select PBをクリッ

クすると積算回数を各元素ごとに変更出
来ます 
• 例えば(P-B)/BはPB同時法ではBを2点以上で取っている場
合、Bで一次線形関数を作成し、各Pの強度を差し引いた後、
平均のBで割り算しています。その結果をスキャン度に積算
しています。Processingでデータを読み込む時とinvestigator

でデータを読み込む時でマッピングの絵の様相が変わる場
合がありますが、これはprocessingでは上記の計算とは異な
り、P,Bそれぞれの全積算の合算とチャンネル数比を用いた
強度算出をしている為です。Investigatorでは測定度にBの

一次線形関数の作成を行っている強度計算をしており、試
料凹凸の影響をきちんと補正した結果を表出しやすいです。
またInvestigatorではノイズレベルの信号と閾値で判断され
たピクセルを強度０として像を作ります 
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オージェ分析 spectrum line profile 

１～３．wide scan, Line profile 参照 
４．ROIの設定はsplit scanを参照 
６～８．wide scan参照 

 Spectrum Line ProfileはLine Profile
と異なり、PとBだけを取得するのでは

なく、各元素のスペクトルを収集後、
微分形からピークの強度を読み取り、
各ピクセルの分布を表示します 
• スペクトルを取得する為、時間がかなりかかります 
• PとBの指定が困難である場合(スペクトルが安定しな
い、ピーク強度が小さいなど)、スペクトルを波形分離
にかけて線分析する場合などはこちらを使います 

上段が取得しているスペクトル 
中段がスペクトルの微分形 
下段が微分形を元にした強度/ピク

セルのグラフで、左側のピクセルか
ら徐々に線分析が進んでいきます 
• スペクトル中の微分形の極大-極小値の差分が強
度になります 
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オージェ分析 depth profile 

１．分析エリアの取り込み 
 wide scan参照。必ずユーセントリック位
置に合わせてください 

２．分析条件の設定  
 オージェマスター→ AES → Depth profile→ 
Depth profileでウィンドウが立ち上がります。 
Analyzer ConditionでAnalyzer mode, 
Number of Cycles, Auto Probe Trackingを設
定します(利用時)  
• Number of CyclesはAr+エッチングと分析のセットを何回行うかで
す。なお、初回は必ずAr+エッチングなしの分析になります 

• Auto Probe Trackingはステップの種類をCycles、ROI、Sweepsか
ら選択出来るので動きすぎない間隔に指定してください 

• どのくらいの深さ間隔で削って分析していくべきかですが、オー
ジェは表面から2nmまでの深さから出てくる電子が全体の9割を
占めています。なので2nm刻みでデプスプロファイルを実行出

来ればほぼ取りこぼしがないと言えます。各チャンネルエッチン
グレートと材料のエッチングレートを勘案してCyclesやetching 
timeを適切に指定してください 

• またAr+エッチングを用いて化学状態の相違を見たい場合はAr+

エッチングによる影響での化学状態の変化がないかどうか検証
する必要があります 

４．ROIの設定 split scan参照 

３．分析箇所の設定 wide scan参照 

５. イオン銃の設定 
 Ar+エッチングを参照してArガスの導入、ガ
ス圧の調整を行います 
 Depth profile→Conditions→Ion Gun 
Controlでエッチング設定ウィンドウを立ち上
げます 
 上部のEtchingメニューでエッチング条件の
Channel番号を選択します 
• 使えるのは1,2,4のどれかです。隣の秒数は指定しません 
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オージェ分析 depth profile 

 中段にあるDepth Profile and Cross-
sectionでEtching TimeとRelaxation Time
を入力 
• Relaxation TimeはAr+エッチング後に用意される電場の
緩和時間です。大体10秒で問題はないと思います。予備
測定でスペクトルが安定しているかチェックして下さい 

 Stage RotationでOnかOffかOne-way
のどれかを選択 
• Ar+エッチングを一方向から照射し続けると表面が荒れ

やすい為、ステージを回転させながら照射する事で荒れ
を軽減させます。OnよりOne-wayの方が元の位置に戻り

やすいですが、どっちみち結構ずれるので細かい分析位
置を指定している場合はOffを推奨します。表面のどこを
測定しても問題ない場合はOne-wayを選択して下さい 

６．Auto probe trackingの設定 
• wide scanを参照、ステージを回してると画が追

えない可能性が高いです 

７．予備測定 
• wide scanを参照。エッチングは行われません 

８．本測定 
 Acquisitionでstartします。上段に各
ROIのスペクトル、中段に微分形、下段
に各ROIが色付けされてIntensity/cycle
のグラフが出てきます 
 Sputter ConditionsにはAr+イオンガン
の状態が表示されます 
 測定中に上部メニューでCycle、各ROI
のSweep、エッチング時間を変更する
事が出来ます 
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オージェ分析 auger image 
１．分析エリアの取り込み 

• ほぼ間違いなく長時間測定になるのでSEMの取り込
みはImage Fine Shiftを初期値に戻してAuto probe 
trackingの機能が使えるようにしてから行ってください 

２．分析条件の設定  
 オージェマスター→ AES → Auger Image→ 
Auger Imageでウィンドウが立ち上がります。 
Analyzer modeとAuto Probe Trackingを設定
します 
３．分析箇所の設定 
  Auger Image→ Condition→ Analysis  area 

でオージェマスターに取り込んだ画像から
分析する領域を指定します 
 Selectionで全体か領域指定かを選びます。

指定する場合はマウスでドラックします。
Resolutionで解像度を指定します 
• 領域指定をしている場合は領域のピクセル数がResolution右
横に表示されます。解像度を倍にすると測定時間は4倍です 

４．ROIの設定 
 split scan, line profileを参照 
 PとBを取得して強度の定義に従い、画を
作ります。PとBの取得方法はPB別法、PB同
時法から選べます 
• PB別法よりPB同時法をお勧めします。PB別法は倍の時間が

かかりますのでマッピングだとなおさら長時間測定になります。
またマッピングのPB同時法による測定だとimage investigator
であとから各チャンネルのP及びBの設定を変更する事が可能
であり、analyzer modeの違いによるピーク、バックグラウンド
のズレによるP,Bの取得ミスをある程度修正出来ます 

６．Auto probe trackingの設定 wide scan参照 

８．本測定 各元素のスキャンの一回目が終わってからデー
タを操作する事が出来ますので、PBの設定が問題ないかどうか
image investigatorで確認してください(PB同時法の場合) 
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終了の仕方 
• まず初めに 

ハードウェア・ソフトウェア上の各パラメータを始めの状態に戻します
(対物絞り番号、電圧電流値、SEMモード番号、Analyzer Mode、Auto 
Probe Trackingなど) 

• Ar+イオンガンを使っている場合 
試料の取り出しより先にArガスの導入を止めてください 
・オートバルブコントローラーの電源を切る 
・冷却時間として3分待つ 
・Arガスバルブを時計回りに1回転回す(6時の方向に戻す) 
・イオンガンの真空計のAVCボタンをOFF 

• 反射電子検出器を利用またはEBSD測定をしている場合 
ステージの試料交換位置への移動の前に反射電子検出器及び
EBSDカメラを抜いて元に戻して下さい。特にEBSDカメラは必ず先にカ
メラを抜いて下さい 

• ステージを試料交換位置へ移動 
導入時と同様にsample  manipulation →special positionを選択し、
Moveをクリックしてホルダー選択 

• 試料の取り出し前 
2次電子検出器はOFF、PCDはIN、鏡筒のコックは閉じます。分析室
の真空計をONにし、分析室の窓から中を覗けるようにします 

• 試料の取り出し 
V2ボタンを押してV2バルブ解放、黒いリングを押し出し、開→閉へ回
してからリングを引き抜いてから再びV2ボタンを押します。必ず目視
確認する事。試料導入室のロックを外し、VENTボタンで大気へ戻し
ます 

• 試料の取り出し後 
試料導入室をまたVENTし、必ず真空に引き直してください。ホル
ダーは洗浄後、デシケーターへ。データは研究室のUSBで取り出す
か、オージェ解析用PCのネットワークからアクセス、PCはSEMソフト

ウェア、オージェマスターは開いたまま、ディスプレイの電源だけ消し
て下さい。分析室真空度をチェックし、記録簿に残りの項目を記入。
机にゴミを残さないでください 
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分析データの保存・編集 

 ・データの呼び出し 
 オージェマスター→Processing→List 
dataから自分のフォルダを選択し、呼
び出すデータをクリックします 
• 下部のデータ一覧にデータの種類について記載あり 

・画像データの編集・保存 
 SEM像やマッピング像など画像データは

最大４つまでウィンドウに開けます。左側
に良く使うコマンドが載っています。下部に
は像取得時の諸設定が載っています 
 
 良く使う機能について紹介します 
 

Cursor:画像中にマウスを置くと
そのピクセルの強度が出る 

Expand:画像中の一部をド
ラック操作で拡大出来ます 

Add Labels:画像中に文字を載せ
られます。Writeを押して画像の
載せたい場所でクリックします 

ラベルを消したい場合はDeleteを

押して消したい文字をドラッグ操作
で囲みます 

Reset Displayで元絵に戻します 

左のトグルボタンで画
にカラーバーやスケー
ルや倍率を追加します 
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分析データの保存・編集 

Histogram:画像の色調を変更出来ます 

Display→Analysis point 及びarea:画像中に分析点、

分析エリアを載せる事が出来ます。載せたい分析
データを呼び出してApplyして下さい。マーカーの
名前を変更する事も出来ます 

Display→Line Profile:画像中に線分析の分

析位置及び測定結果を載せる事が出来ま
す。載せたいデータを呼び出してApplyしま
す。載せ方を変更する事が出来ます 

Display→Affine Transform:画像の拡大、
移動、回転が出来ます 

Display→Hardcopy Display:画像を出力

します。取得時のパラメータを付ける
か選択出来ます 

出力した画像上で右クリック
しながら、出てきたSave 
windowというコマンドにマウ

スをドラックすると画像を保
存するメニューが出てきま
す。.pngの形式で画像の保
存が出来ます 30 



分析データの保存・編集 

Calculate→Median Filter:画像をぼかさずに突
発的なノイズを除去します Calculate→Smoothing:スムージング処理をし

ます。幾つかフィルタの種類があります 

Calculate→Noise Cleaning:注目するピクセル
を周囲8ピクセルの強度平均値との差が閾値

より大きければそのピクセル強度を平均値に
変更してノイズを除去します 

Calculate→Simple Calc.:画像間の四則演算
処理をします。Weightは重み付け係数です 

Calculate→Statistic Filter:強度の分散値
√(P-B)の係数倍の閾値より低ければノイズ
と判断し、そのピクセル強度を０にします 

Calculate→Gaussian Statistical Filter:ガウス

ぼかし処理とアンシャープマスク処理後に
Statistic Filterを行います。平滑化しつつ輪郭
が強調され、かつノイズを消します 
閾値の係数は2.0ぐらいがいいです 
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分析データの保存・編集 

Analyze→RGB Synthesis:マッピングデータを複

数開いた状態で、各元素を赤青緑で重ね合
わせた画像を作成出来ます 

Analyze→Color/Monochro Image Synthesis:SEM
像及びマッピングを開いた状態で、SEM像上に
各元素のマッピング像を色分けして重ねます 

Analyze→Scattering Diagram:二つの画像を開

いた状態で、その画像間の各ピクセル間で散
布図を作成します。相分析に使えます 

Analyze→Intensity Definition:マッピングの強
度の定義を変更します 

Analyze→Quantitative Analysis:マッピングの強度分
布にRSFの値を用いて定量マップ化させます(atm％) 

編集した画像はFile→Save asで保存
出来ます 
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分析データの保存・編集 

・スペクトルデータの編集・保存 
 スペクトルデータも画像と同様にList 
dataから開きます。左側に良く使うコマ

ンドが載っています。下部には像取得
時の諸設定が載っています 
 
以下に良く使う機能を紹介します 
  

Cursor: スペクトル上の2本のカーソル

位置からエネルギー値や各定義の強
度を読み取れます 
Expand: マウスドラッグでスペクトルの
一部を拡大表示出来ます 
Reset Display: 表示を元に戻します 
Smoothing: 7点のデータ点数を用いて
平滑化させます 
1st Differentiation: 7点のデータ点数
を用いて微分化させます 
Add labels or Comments: スペクトル中

にラベルやコメントを記入出来ます。
画像データの編集・保存を参照 

Calculate→Deglitch: スペクトル

のスパイクノイズを取り除きます
(このピークは別にノイズではありません) 
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分析データの保存・編集 

 Depth profileやline profileなど

のデータの場合は以下のような
機能があります 

Display→Show Retro Data: 左図のよう

なグラフ作成にための各種設定をしま
す 
• Range設定 
• increment数指定(何個飛びにスペ
クトルを表示するか) 

• White Washの選択(隠れ線かどう
か) 

• 積分形微分形選択 
• 表示角度、Y/Z軸の調整 
• スペクトル拡大表示の設定 
 

Display→Intensity Definition: 強度の設定を
変更します。選択後、Applyをクリック 

Display→Change Display Condition: 表示す
るprofileのON,OFF、Gainの変更、RSFの変
更を行います。変更後にEnterをクリックし
て反映されます 
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分析データの保存・編集 

 複数のスペクトルを重ねて
表示したい場合はオージェマ
スター→ Processing →List data 
→ File → Multiple Spectrum 
Displayでデータを選択すると
色分けされて表示されます 
 Display、Calculateメニューか

ら微分化して表示したり、拡大
縮小、重ね方の変更などが出
来ます 

Calculate→Differentiation: 微分の
点数を指定して微分出来ます 

Display→Display Conditions of 
Data: 各スペクトルごとに強度拡
大やシフトなどを変更出来ます 

Display→Hard copy display→3D 
Display: スペクトルを3次元表
示出来ます 

スペクトル画像データの保存はDisplay→ 
Hardcopy Displayから右クリックでSave 
windowを選びます。.png形式です 

編集データの保存はFile→Save asで行います。ス
ペクトルを.csv形式でほしい場合はオージェマス
ター→ processing → Data Conversionで変換したい
形式やデータを選択して行えます 
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分析・解析について 
 ここでは各種ソフトウェアを利用した一般的な解析について説
明します。AESには元素同定・簡易定量などを行うオージェマス
ター、波形分離を行うspectra investigator、マッピングの設定変
更を行うimage investigatorの三種類のソフトウェアがあります 
 

・オージェマスターでの解析 

KLM Marker: 元素を選択すると

ピークのラインが表示されるので
容易に元素同定が出来ます。
Labelボタンを押すと元素名がスタ

ンプされます。積分形でも微分形
でも同定出来ます 

 processingでスペクトルデータを開
き、Analyzeメニューから選びます 

N(E) Qualitative Analysis: ピークの

元素同定を自動で行います。積分
形のワイドスキャンのみ可能 

 Display Rankで同定の確
度の表示を変更。Apply

で同定し、リストが表示さ
れます。同定されない
ピークはX表示になります。
リストはEditボタンで変更
出来ます。Labelボタンで
スタンプします 
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分析・解析について 

Quantitative Analysis: 相対感度因
子(RSF)法により定量を行います 
 
 ROIに定量する元素を入力すると、強度を
測るエネルギー範囲とRSFの値が出てきます。
Enterボタンでリストに載ります。リストから消
す場合はDelete。Applyボタンで定量計算結
果が表示されます 

 リスト上の元素をクリックすると、強
度を測るエネルギー範囲が青線で
表示されます。デフォルトのエネル
ギー範囲だと別のピークが含まれる
事もあり、強度の値が大きく見積も
られる事があるので調整して下さい。
青線を動かしてからEnterを押すと変
更出来ます 
• ピークが別の元素と被っている場合

は強度が大きく見積もられるので定量
値はずれ込みます。その場合は波形
分離にかけるか、被っていない別の
ピークをRSFの値を調整して定量にか
けると良いです 

↑Crのエネルギー範囲に
Oのピークが入ってます 

↑微分形の場合はピーク
の極値を捉えてください 

ピーク値の一覧表(微分
形)やスペクトルのハンド
ブックが用意してあります 

 aesディレクトリ下に各元素

の標準スペクトルのデータ
があります(StandardSpec2)。

測定時のアナライザーモー
ドに合わせたディレクトリ
(M2からM5)を選び、一覧

からデータをクリックすると
スペクトルを確認出来ます 
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分析・解析について 

Depth profileデータの場合 

ROI Modification: ROIの

設定条件を変更出来ま
す。ROIの範囲の変更
や一つのROIで２つの

ピークを取っておいて
分離する事が出来ます 

• 変更したいROIを選んで右下のスペクト

ルを見ながら青のラインを動かして
Enterし、Apply 

• ROIを追加(分離)する場合はNewをク
リックしてROI名を入れ、元となるスペク
トルを選択、範囲等を指定しEnter後、
Apply 

• 左下のsearch peak shiftにROIとprofile
範囲を指定してEnter、Applyした後に
Confirmボタンを押すとpeak shift量の
一覧で出ます 

Retro to Spectrum: depth profile

のスペクトル群から個別のスペ
クトルを抽出して保存したい場
合に使います。保存したいCycle
を選択し、AddでSave Cycle List
に載せて右上のSave asで保存
します 
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分析・解析について 

・Spectra investigatorを使った解析 

 Spectra investigatorを開き、File→ 
Open JAMP dataからスペクトルデータ
を開きます 
 以下に主に使う機能を紹介します 

スペクトルを積分形・微分
形表示に変更します 

Mag.を押してからスペクトルの

拡大したいところをクリックする
と拡大表示します。拡大したい
範囲を囲む事で拡大エリアを
指定出来ます 
グラフ軸上をダブルクリックすると表
示範囲を数値入力で変更出来ます 

Depth profileの場合表示する
Cycleを変えられます 

Split scan、Depth profile

の場合、表示する元素を
変えられます 

 スペクトル上で右クリックすると左図のメニューが
表示されます 
Make new ROI: depth profileで指定したROIの範囲を
変更して新しく登録します 
Save as: スペクトルをファイルに保存します。画像や
数値ファイルとして保存出来ます 
Copy to clipboard: 画像をコピーします 
REF import: 波形分離する時に使うスペクトル(標準
スペクトル)を読み込みます。標準スペクトルのデー
タはhome/aes/standard spec2以下にあります。
Analyzer modeを測定条件と合わせてください 39 



・波形分離、化学状態分析について 
  

 重なったスペクトルの分離や化学
状態を同定する上で、測定したスペ
クトルを標準スペクトルでフィッテング
させます 
 
1. Mag.を使ってスペクトルを拡大表

示します。表示してる範囲が計算
範囲になります 

2.  REF importで必要な標準スペク
トルを呼びます 

3. 右下のFitting condition and calc.
をクリック 

4. Shift limitをチェックマークをつけ、
Applyします 

5. Spectra analysisリストに結果が表
示されます。 
• mag.が重み係数でshiftはfittingした際のエネ
ルギーシフトです。Convolution curve, residual 
curveにチェックマークをつけるとグラフ上に合

成したスペクトルや差分を表示出来ます。
真っ当な波形分離が出来ているか差分などを
見て確認してください 

分析・解析について 

 例えばこのSiピークのほとんどがSiO2の状態
であると出ています。メタルSiと酸化Siの定量
をする場合はSiO2のmag値を1/3した値とSiの
mag値を使い、百分率に規格化して下さい。
SiO2標準スペクトルのSiが33.3atm％だからで

す。標準スペクトルに存在する元素の割合を
magに掛けるのを忘れないように 40 



分析・解析について 

 Depth profileデータを開くと各ROIの
スペクトルとprofileが表示されます 
 以下で良く使うprofile機能を紹介し
ます 

X-axis: X軸の表示を切り替
えます 

Y-axis: Y軸の表示を切り替え
ます 
• マトリックス効果を補正したatm％を出

す事も出来ます 

ROI select: グラフに表

示する元素を選択しま
す。相対感度因子を入
力出来ます 

 depth profileデータを波形分離にかけ
てそれぞれのprofileに書き直す事が出
来ます 
1. 波形分離する元素をSpectrum selectで

選択 
2. 微分表示にし、REF importで標準スペク

トルを呼び出し、波形分離する(apply for 
depth選択) 

3. Profileに分離した波形の強度による
profileが表示されます 
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分析・解析について 

 Target Factor Analysis: depth profileのスペクトル群から、いくつ
の成分でそれらのスペクトルが構成されているか見つけます 
1. profileウィンドウの右下にあるopenをクリック 
2. ROI selectで元素選択、微分形表示にする 
3. Analysisボタンをクリック。結果が表示されます。右グラフには各構成

スペクトル及びnumberとcycle数が、左リストに構成スペクトルの寄与
率が表示されます 

 Depth profileデータで波形分離

をかけたい時、その標準スペクト
ルを測定したそのdepth profile
データから用意する事が出来ます 
 
• 例えばシリコンウェハーのデプスプロファイル
データを波形分離して酸化Si-メタルSiのプロファ

イルを描きたい時、標準スペクトルを利用せずに
デプスプロファイルのスペクトル群からもっとも酸
化Siスペクトルっぽいもの、もっともメタルSiスペク

トルっぽいものを計算から見つけ、それらのスペ
クトルでスペクトル群の波形分離をかけるみたい
なことです 

 構成スペクトルを標準スペクトルとして利用する為にスペク
トルを保存します 
1. Spectra investigatorウィンドウで積分表示を選択 
2. 標準スペクトルに利用するCycle数をcycleに入力する 
3. 表示されたスペクトル上で右クリックしsave asでJAMPフォーマット

で保存 
4. 保存したスペクトルをREF importで呼び出し波形分離 

 このように波形分離に使う標準スペクトルを自分で測定したものを利用するのが一番良い
やり方です。Depth profileに限らず通常の波形分離でも出来るだけ自分で標準試料を用意し、

標準スペクトルを作成した方が良いと思います。その際には試料の測定条件と標準試料の測
定条件を一致させましょう(逆に言うとデータベースの標準スペクトルを使う場合は標準スペク

トルの測定条件に合わせた試料分析を行うべきです。条件が違っても補正はしていますが補
正にすぎません) 
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分析・解析について 

・Image investigatorを使った解析 

 image investigatorを使ってマッピ

ングデータの編集を行う事が出来
ます。特にPB同時法で測定した
データではP,Bの変更、試料のドリフ

トにより失敗したマッピングの積算
を無しにする事が出来ます 
  
 以下で良く使う機能を紹介します 

Contrast/Brightness：色調の変更をします。
画像中で右クリックし、Contrast/Braightness
を選択します 

RGB synthesizer: ３つのマッピングデー
タを色付けて重ね合わせます 

重ね合わせるマッピングデータを全て
呼び出してLauncher一覧に載せてから
Processing→RGB synthesizerを選択し
ます。Selected Fileで重ねるデータを選
択し、Applyにチェックマークをつけ色
調を調整してOkをクリックして保存して
下さい 
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分析・解析について 

・各channelのPB設定の変更 
PB同時法で測定したデータを呼び出して
から右のアイコンをクリック 

Samping area: CEM 
conditionに表示される各

チャンネルの強度に反映
するデータ範囲を指定し
ます。Select areaを選択し

て画像中をマウスドラッグ
するとその範囲内のデー
タがCEM conditionに反映
されます。 Image Switch: 強度をP-B、

(P-B/B)から選択します。
Cycle editでscan回数を指定

するとその積算分のみの
マッピング像が表示されま
す。失敗したscan回を積算
から削除したい場合はscan

回を選択して右クリックする
とdeleteが選べます。最後に
OkをクリックするとPB 
constructorのマッピング像
に反映されます 

CEM condition: 各チャンネルの
PB設定を変更出来ます。Peak, 
Back, Noneから選択出来ます。
設定が終わったらOkをクリックし
てPB constructorにマッピング像
に反映させます 

例えば上図の場合
は+2ch,+3chに別の

ピークが出てきて
いるので左図のよ
うにチャンネルを再
設定した方が良い
かもしれません 
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